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Log in 
Your agency’s administrator will add users and give you your user name and password. Each user should 

have their own login account in order to maintain a better record of changes that were made. 

 

Permissions: Depending on the user role you were assigned, you may or not be able to do certain things 

such as delete records, delete clients, view case notes entered by others. Users with the Volunteer role 

will not be able to see any client information. Only agency administrators can change drop-down 
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options, set required fields and default values, and add/edit user accounts. Only the main Administrator 

can modify the screen layout (which can be risky if you don’t know what you are doing). 

 

Home Screen 

The first time you log in you will probably see a list of people in the database. If you have a blank screen, 

open the File menu (top left) and click “People.” That will give you an icon ribbon at the top similar to 

Microsoft Office programs. The items in the ribbon will change depending on what screen you are 

viewing. 

 

*Some Differences from the Alice database 
(not a complete list) 

 

Intakes 
The Alice database had different places for intakes for adult-shelter, child-shelter and nonresidential 

clients. Client information was repeated (or sometimes updated) in each intake for a client. 

Activities/services were split up and connected to a particular intake. 

- WS has one record for each client or child/dependent. If anything in their profile or contact 

info changes, you update it in the client record. (If you want to keep a record of old information, 

enter it in the Notes area) 

- You can create multiple intakes for a client, but all of the activities are together and not 

associated with a particular intake. You see everything about a client in one place. 

 

Bed Nights 
The Alice database required you to enter a bed night for every night a person stayed in shelter. 

- WS has a Stay record, where you enter the Admission Date and Discharge Date, and the nights 

are automatically calculated. 

- You can enter related Stays and designate a head of household to connect family groups. 

 

Depart 
The Alice database required you to “Depart” a client in order for them to not be active. There is no such 

feature in WS, but you can change a client’s Status to Inactive if you like to make searching/sorting 

easier. It’s for your convenience and won’t affect services reports. 

 

My Clients 
There is no “My Clients” list, but you can designate a Primary Advocate for a client and filter your list 

based on that. Or you can run a report of activities based on the staff that provided the activities. 
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Navigating 

File Menu    
The icon at the top left of the screen brings up a menu of all the areas of the database that your 

permission level allows you to see. If you don’t see what you need by clicking the “New” icon, try the 

File menu. 

 People  

 Hover over People to select Clients Only, Children/Dependents Only, or Reported Abusers Only.  

 Hotline Calls 

 Scheduler 

 Events 

 Volunteer Time 

 Donations 

 Lists > Services, Group Services, Stays/Departures/HMIS, Intakes, Referrals 

 Reports 

 Users 

 Other > Survey 

 Waiting List 

 

Ribbon 
The ribbon across the top is similar to Microsoft Office’s ribbon. The groups and icons change depending 

on what screen you are viewing.  

 

Home Tab 
This is where you will find your most common icons. 

View Tab 
You can change your color scheme or navigation options here. If you lose  

Tools Tab 
These are mostly administrative tools. Some may be visible only to people with certain permissions. 

Lists 
You will find lists throughout the database, with columns and column titles. They all work basically the 

same way and a very powerful. 

 

A list can be: 

 For finding and opening a record (People, Events, Hotline Calls, etc.). 

 For listing multiple entries within a person’s record (Stays, Referrals, Releases of Information, 

etc.) 

 Customized lists (File menu > Lists > Services) that include fields from multiple places in the 

database, and may have custom filters in the Filter drop-down on the icon bar. 
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What you can do with lists: 
 

 Search:  Type in “Enter text to search”. Click the Find button to find records with any text that 

matches what is displayed in the search list. You can search a filtered list or the whole list. 

- Click the “Clear” button to clear your search. “Clear” will not remove any active filters. 

- If you don’t see the text search box (you may have clicked the X next to the box and hidden 

it), right-click on one of the column headers and select “Show Find Panel.” 

 Open an item to view or edit: Double-click a row to open the record. 

 Sort a column: Click on the column title. Click again to sort the other direction. 

- Filter from a column header: Hover over a column title and click on the little funnel. Choose 

the option you want. You can only choose one option at a time. If a column-header filter is 

on, you’ll see it shown in red at the bottom of the screen. Check or uncheck to clear/re-

filter, or X to turn it off. 

(Create a more complex filter within a list: Not recommended but this is how: Right-click on any 

column title and select “Show Filter Editor.” You can use and/or logic and grouping. The fields 

may not make much sense, though. And you can’t save a filter this way.) 

 Use or define additional filters: Use the Filter drop-down in the icon bar for more complex 

filters. Some have been predefined. Some of the field names may not match what you see on 

the screen, and you may see some fields that are not used in our database. You can try to create 

your own filters or get help from Osnium or other users. You may want to use reports instead. 

 Calculate: Right-click the strip at the bottom of the column for options. Select Count for the 

number of records (rows), Sum to total the values, or Min, Max, or Average. 

 Download: Filter or sort your data first if you like. Then right-click anywhere in the list area and 

select Export To > select file type. xls, xlsx or csv will all open in a spreadsheet and will be the 

most useful. Note the folder where you saved it. 

HINT: xls and xlsx files will export with tables where you can do more complex filtering. If you 

have any column calculations they will appear at the bottom of the table, or you can add your 

own calculations to the spreadsheet. 

 

CAUTION ABOUT LIST FILTERS 
*Take note of whether a filter is on as you view lists throughout the database. There may be an 

existing record you are not seeing. Check the drop-down filters in the menu bar at the top as well as any 

column filters that may be turned on before you create a new record that may be a duplicate. 

 

You can create new drop-down filters of your own. They will be available to all users, so you might want 

to temporarily preface a new filter’s name with TEST until you know it’s working correctly. 

 

MODIFYING LIST COLUMNS: 
(This applies to ALL lists in the database – in search areas and from the Lists menu) 

We have started you out with the most common items you will likely need for searching.  Changing any 

of the columns will affect ALL USERS. 

Take some time to think about it before you begin to modify columns. 
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 To add or remove columns: right-click on a column header and select “Remove this Column” or 

“Column Chooser.”  

 CAUTION: Some of the fields in the column chooser may be ones we are not using in our 

database, others may not have obvious titles, and some may seem like the correct fields but are 

actually something different. We have tried to rename all of the fields we are using to match the 

forms in the database, but you may see other fields in the list that have slightly different names. 

 

Hotline Calls 
File menu > Hotline Calls 

New > Hotline Call 

 

NOTE: This section is meant for recording calls that come in on the hotline. If you provide services by 

phone to an existing client, you should also enter it as an activity in the client’s record so the service 

will be counted. It is recommended for most funder reporting that you record calls from existing clients 

as both a hotline call and a service if the hotline operator provides any help before transferring the call 

to the client’s advocate for more in-depth services. 

 

File menu > Hotline Calls opens a list of Hotline Calls and also opens a new hotline call record.  

Use the Hotline calls list as you would other lists to find, sort, filter, total and download for analysis. 

 

New > Hotline Call opens a blank hotline call record. 

 

 Name of Advocate is already filled in but you can change it if you are entering calls for another 

person. 

 Funder: Use when you need to assign a call to a specific funders. If your agency never does this, 

your administrator can set the initial value to “Other” or “Multiple funders” or another value 

you have created, and you won’t have to fill it in every time. 

 Service Site, Call Date & Time – self-explanatory 

 Primary Call Type: This field is used for several funder reports (see below). The choice “Outgoing 

contact” was added for agencies that wish to record attempted contacts with clients.  

 Victimization Type: Used for several funder reports. 

 Method of Contact: [Used for several funder reports. “In Person” is meant for agencies who 

allow walk-ins. 

 Abuse Status: [STOP, SASP] 

 Caller Type: For agency convenience, if you track calls from types of people such as law 

enforcement. Your agency administrator will decide which options go in this list and whether 

they want you to use it. 

 

 Existing Client: If the caller is a client in the database, choose from the list. The call will then 

show up on the client’s hotline tab. NOTE: Calls with existing clients should be recorded as an 

activity. 

 Reported Abuser, Relationship to Abuser: For agency convenience. You can add a new abuser 

from this field. 
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 Primary Referral Source: For agency convenience. 

 Call Outcome: [DCF, SAVS, VOCA, STOP, SASP] Used to report unmet needs and unmet requests 

for shelter on several funder reports.  

 

 If Not Existing Client: This information will be used if you “Convert Call to Client” using the icon 

above. Check “Anonymous Caller” if you have no information to enter here. 

 

 Call Notes: do not use for case notes that may need to be purged or hidden from some staff. 

 Call Reasons: For agency convenience. Your agency administrator can change the options. 

 Referral Destinations: [STOP] Pre-populated with general referral destinations, which match 

STOP categories. If you want to use this for more specifics, you or your agency administrators 

can add new destinations. Follow your agency’s guidelines. This field is multiple choice so you 

can choose more than one (hold down the Ctrl key to select multiple options). 

 

Hotline Call Data Required by Funders 

Hotline Calls        

Funder   VOCA STOP SASP   

Primary Call Type DCF SAVS VOCA STOP SASP   

Victimization Type (DV, SA, etc.) DCF 
(DV or 
Dual 
DV/SA) 

SAVS 
(SA 
or 
Dual) 

 STOP SASP  Same field choices used 
for Intakes and Events 

Method of Contact DCF SAVS VOCA STOP SASP  Same field choices are 
used for Activities 

Abuse Status (Primary/Secondary)  SAVS  STOP SASP  Same field choices are 
used for Intakes 

Call Outcome DCF SAVS 
 

 STOP SASP  Some options are used 
to report unmet needs  

Call Reasons   VOCA     

Referral Destinations   VOCA STOP   OK to change options 

 

People Records 
 People can be Clients, Children/Dependents, or Reported Abusers. 

 Children/Dependents and Reported Abusers can be linked to a Client. 

 Abusers who are clients should be entered as Clients. 

 You can change the person type if necessary. 

 

Finding People: Person List 
File menu > People 

 

The Person list is a list of all people in the database: Clients, Children and reported Abusers. 

 Note whether there is a filter on!  

- Check for filters before entering a record that may be a duplicate. 



 

Osnium WS Basic User Manual page 9 of 29 End Domestic Abuse WI DRAFT 9/30/2015 

- There are 2 filter drop-downs at the top of the screen. Check them BOTH. 

- If a column-header filter is on, you’ll see it shown in red at the bottom of the screen. Check 

or uncheck to clear/re-filter, or X to turn it off. 

 

To view a list of Clients Only, Children/Dependents Only, Reported Abusers Only 

File menu > People > click a sub-item 

 Each list has slightly different columns. 

 The “New” icon has options for child/dependent or reported abuser appears when you are in 

the appropriate screen. However, you can add a child/dependent from a client’s record, and you 

can add a reported abuser from a client’s intake, court case or restraining order.  

 If you enter a child/dependent separately, the child/dependent connects to the client by 

selecting the client in the Parent field. 

 Reported abusers added separately, or added to an intake do not connect the client. Go to the 

abuser’s record and click Add to select the client in the Associated Clients tab. Selecting an 

abuser in a court case or RO will automatically add the case/RO to the Related Cases/ROs tab. 

 

Double-click a row to open a person’s record. 

 Information at the top stays with the person, and can be modified if anything changes. The 

General Information tab has more information about the person. Neither of these is affected 

when there are new intakes.  

 Tabs have additional information that is linked to the person. There are different tabs for 

Clients, Children/Dependents and Reported Abusers. 

 

Child/Dependent Record 
File > People > Children/Dependents Only to view a list with appropriate columns. 

 

The record is similar to Client with a few differences: 

 Parent, Custody, Schools 

 Address of parent will fill in when record is saved; can enter a different address. 

 No Court Advocacy/RO tab 

 The child will link to the client entered in the Parent field, and will appear in the client’s 

Children/Dependents tab. 

 

Reported Abuser Record 
File > People > Reported Abusers Only to view a list of abusers with appropriate columns, including 

Abuser Status. 

 

*NOTE: Reported Abuser records are not for CLIENTS – they are informational records of abusers that 

clients have reported. For abusers in an offender program, create a Client record and enter activities in 

the Offender Treatment Category. For ease of searching and filtering, you will also want to make the 

Primary Program Offender Treatment or a similar program you have in your options. 

 

 Basic demographics  
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 Description 

 Photo – Double click to add an image file; right-click to load or delete 

 Abused Substances 

 Notes for anything else 

 Related Cases/ROs appear based on the Reported Abuser or Respondent in a client’s Court 

Advocacy record. 

 Associated Clients: Click “Add” and select one or more clients from the list. 

 

People Tools 
 

Merge Objects  
Use this button on the icon bar if you have 2 client records for the same client and you want all of their 

information in the same place.  

 Start with the client record that has the most updated profile information as the main record. 

 You will be asked to choose from a drop-down list the client record you want to merge, which 

will be deleted after the merge. 

 Information from the client selected in the drop-down will be copied to blank fields in the main 

record; all records in related tabs will be moved to the main record. 

 

Change Type  
Tools > Change Type 

Use this if a child/dependent becomes an adult client, or if an abuser becomes a client.  

 A record of the new type (Client probably) will be created. All items from tabs will be moved to 

the NEW record and removed from the old one.  

 You may wish to delete the old person record to prevent confusion when entering new 

activities; save information from the person’s old profile in Notes if you wish (parent, abuser 

info, etc.). 

 

Show Report 
Some reports are easily accessed from here. We will be requesting a client snapshot report that includes 

profile information and most items entered in tabs. 

 

Enter a New Client 
New > Client 

 

*Important note about SAVING 
If you add or edit anything in one of the tabs, you must also SAVE THE PERSON to save what you’ve 

done. 
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 Fields in Bold are common fields used by many agencies and funders.  They don’t work any 

differently than the non-bolded fields, it’s just for emphasis. (An administrator can change these 

by modifying the screen layout, which should be done with caution – see Administrator manual). 

 Required fields are outlined in red. These can be changed by an administrator. 

 Initial values – some fields are already filled in with default values. These can be removed or 

changed by an administrator. 

 Drop-down lists – many are prepopulated with values required for funder reports, or based on 

common agency use. These can be changed by an administrator to reflect your agency’s needs 

and funding sources. 

 Multiple choice lists (in boxes) – You can choose more than one by holding down the Ctrl key, or 

a block of items by holding down the Shift key. 

 Date fields – click on the month or year in the drop-down window to navigate to other months 

or years, or to clear the data. 

 Clear a field: For more fields, click the X. For linked records, click “Remove.”  

 

HINT – click the Save button periodically so you don’t lose data in case your computer shuts down. 

 

Client Profile - a few things to note: 
 

 First Name + Last Name: if you enter an exact match you will be prompted if there is a duplicate 

already in the database and you can double-click to open that record. If it’s not the same person, 

continue. If you enter something close, it will not be found, so make a habit of searching your list for 

existing clients before entering a new one. 

 

 Status: This is for your convenience (similar to “departing” a client). It has no effect on funder 

reports, which are based on when someone has received services or shelter. 

 

 Agency ID: Use if your agency has an ID system, otherwise you can leave it blank. Person ID is 

assigned by the database which is a standard database thing used to connect related data. 

 

 Age/DOB/Estimated: Enter either of these to calculate the other. Change as needed and check or 

uncheck the box as appropriate. 

 

 Client Alert: If checked, this will pop up a message when you open the client from a list. You can 

filter by this field in the Person or Client list to find all people with alerts. 

 

 Primary Program: This is for your agency’s convenience in searching for clients and reporting. The 

list should be customized to reflect your agency’s programs. 

 

 Review Data checkbox: this is a convenience item, in case you are working on a record and need to 

come back to it; you can filter these records in the Person list. 

 



 

Osnium WS Basic User Manual page 12 of 29 End Domestic Abuse WI DRAFT 9/30/2015 

 Phone numbers: click … to enter. The number you choose as primary will appear on the client’s 

profile. If you type any restrictions, “Restrictions apply” will appear in the phone number field. Open 

the phone numbers area to read notes and find out which numbers are safe to call.  

 Address: Click … to enter. Enter the zipcode to populate City, State & Country if you are connected 

to the internet (values come from the Google maps database; your data does not go out on the 

internet). All Wisconsin counties are on this list. Use the existing values or select “Don’t Know” or 

“Not Wisconsin” for out of state unless you have a reason to add a non-Wisconsin county.  Use 

existing values when possible; for city, state or country not listed use the New button. County shows 

up separately, you can enter it in either place. 

 

 General Information - Other Demographic Characteristics: This is a good place for agencies to 

collect other information about a client that needs to be totaled or reported. Administrators can add 

options here. Use the Notes field if it’s just something you reference when looking at that client. 

(NOTE: if you have HUD funding, some of this information must be re-entered in the HUD module in 

Stays.) 

 

 Notes: Do not use for case notes that you want to be able to purge or hide from users without 

permission to view case notes, or who can only view their own case notes. Your agency may not be 

using this feature of Case Notes; follow your agency’s guidelines. 

 

Client data required by funders 

Client Profile        

Date of birth/age DCF SAVS VOCA STOP SASP HUD  

Gender DCF SAVS VOCA STOP SASP HUD  

Primary Race DCF SAVS VOCA STOP SASP HUD  

Races (multiple choice) DCF       

Hispanic/Latin@ DCF SAVS VOCA STOP SASP HUD  

Primary Language DCF       

Limited English Proficiency DCF  VOCA STOP SASP   

Urban/Rural    STOP SASP   

County DCF SAVS      

Client General Information        

Disability (Y/N)   VOCA STOP SASP  The HUD module includes 

specific disability fields. 

You may add choices to 

“Other demographics 

characteristics” if you 

need specifics for other 

reporting. 

Sexual Orientation  WCASA 

(not 

requ.) 

VOCA 

(not 

requ.) 
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Other demographics/Characteristics        

Deaf/deaf    VOCA  SASP   

Hard of Hearing   VOCA  SASP   

Homeless   VOCA     

Immigrants/refugees/asylum 

seekers 

  VOCA STOP SASP   

Veterans   VOCA     

 

Saving a Client Record 

 Click Save, Save and Close, or Save and New. 

 You will be prompted to “Please select a Main Victimization from the Intakes tab.”  Click Ignore to 

save the client and then go to the Intake tab to enter an Intake. Your first Intake will be entered as 

the main victimization as soon as you save it.  

 If you are not ready to enter your intake yet you can continue to ignore this warning, but you will 

get it every time you try to save this client. The Main Victimization is used to search and filter clients 

by DV/SA/Dual/Other in many places, and you may use it to filter some reports. 

 You will also be prompted to fill in any required fields that you have left blank. They will be obvious. 

 

Status Bar 
At the bottom of every record you’ll see who is currently logged in, who created and last updated the 

record and when. There is also an audit trail that shows every detail of changes to a client’s record (in 

the Tools menu). 

 

Refresh 
  If you don’t see your new entry in the search list, click the “Refresh” button on the icon bar. 

 

 

 

 

SAVING INFO IN CLIENT TABS 
*Information entered in any client tab is NOT SAVED UNTIL YOU SAVE THE CLIENT. 

 

Client Tabs Overview 
Each tab has a list view, sort/filter/columns work like the Person list. Double-click to open an individual 

item, or New to create one. In some places you can Add which takes you to an existing list to choose 

existing items to attach to this client. 

 

 General Information – additional client profile information 

 Children/Dependents that have been associated with the client 

 Intakes – one or more intake/victimization records. One is selected as the Main Victimization. 

 Activities (services) 

 Stays/Departure/HMIS – bed nights, vouchers, transitional housing, etc. 
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 Hotline Calls –if you enter an existing client when entering a hotline call, it will appear here. You 

can also link existing calls or enter a new call here for this client. BUT if you are providing a 

service by phone to an existing client, you should enter it as an activity and select that it was 

provided by phone. More details in the hotline calls section. 

 Releases of Information 

 Referrals 

 Court Advocacy/RO’s 

 Outcomes 

 Surveys (if connected to a client) 

 Waiting List (full waiting list available under Lists) 

 Case Notes (with options for who has access to which case notes as opposed to Notes fields) 

 Billing Information 

 File Attachments 

 
 

Client Tabs 

Children/Dependents tab 
You can create a new Child/Dependent record using the tab in the Client’s screen, or you create a child 

record separately and then link it to the parent. 

 

Enter a Child/Dependent from the Client screen 

 SAVE any changes to the client record before creating a new child record from the client tab. 

 New: Create a new child/dependent record from here, linked to this client. Client info doesn’t 

carry over to the child; you have to enter it separately. 

 Add: Link an existing child record to this client. 

 

Enter a Child/Dependent record separately 
File menu > People > Children/Dependents Only 

New > Child/Dependent 

 Selecting a parent from the list of existing clients will link this record to the parent. You may 

need to refresh the parent’s record if it is already open, to see the child in the list. 

 

Child data required by funders 

Child/Dependent Profile        

Date of birth/age DCF SAVS VOCA STOP SASP HUD  

Gender DCF SAVS VOCA STOP SASP HUD  

Primary Race DCF SAVS VOCA STOP SASP HUD  

Races (multiple) DCF       

Hispanic/Latin@ DCF SAVS VOCA STOP SASP HUD  

Primary Language DCF       

Limited English Proficiency DCF  VOCA STOP SASP   
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Urban/Rural    STOP SASP   

Child General Information        

Disability (Y/N)   VOCA STOP SASP HUD* The HUD module includes 

specific disability fields. 

You may add choices to 

“Other demographics 

characteristics” if you 

need specifics for other 

reporting. 

Other demographics/Characteristics        

Deaf/deaf   VOCA  SASP   

Hard of hearing   VOCA     

Homeless   VOCA     

Immigrants/refugees/asylum 

seekers 

  VOCA STOP SASP   

 

 

Intakes Tab  
Be sure to add an activity for the time you spent conducting an intake. 

 

Main Victimization: If you have more than one intake, this determines the Victimization Type that 

shows up in various client lists and reports. Your first saved intake will become the Main Victimization. If 

you have subsequent victimizations, you may wish to select one of these as the Main Victimization 

instead. 

 

New intake: 

 Existing required fields are based on DCF, SAVS, VOCA, VAWA and HUD reporting requirements. 

These can be made optional by an agency administrator if you don’t have that funding source. 

Refer to the documentation: “WS Fields required by funders” for a chart of which fields can be 

modified. 

 Most common fields are bold. Your agency administrator can change this if necessary. 

 Victimization Type: Domestic violence includes Dating Violence, Stalking and physical or non-

physical abuse by anyone known to the victim. Use Not DV/SA Related only if your agency has 

additional programs for non-DV/SA clients that you track, that are not reportable to DV/SA 

funders (e.g. food pantry). 

 Intimate Partner Violence: A client younger than 18 who has “Yes” here will count on the DCF 

report as Youth IPV. You can use it for adults, too. 

 Initially Presented With: For dual agencies with SAVS funding, this distinguishes sexual assault 

clients from sexual assault with domestic violence. 

 VOCA Primary Victimization: no longer used. As of October 1, 2015, VOCA does not ask for a 

primary victimization. 

 VOCA Secondary Victimizations: As of October 1, 2015, this field will be used to report multiple 

victimization types to VOCA. 
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 All Victimizations: This is for your convenience, but also used to track stalking and trafficking 

data for WCASA and others. Your agency administrator can modify the options. 

 Primary Abuser (optional): Select from existing list or click “New” to add a new abuser. NOTE: 

watch for filters that may be on – don’t add a new abuser unless you’re sure it does not exist. 

 Relationship to Abuser – for reporting to VAWA as well as your own information. 

 

Save and select the Main Victimization at the left. When you save the client, all of the information 

will fill in. 

 

 

 

REMEMBER TO SAVE THE INTAKE and ALSO SAVE THE CLIENT!!! 
 

Activities Tab 
This is the most complex form in the database in terms of how the data is used and reported. 

Do NOT enter bed nights here. 

 

Description of Activities Fields 

 Time/Duration: They calculate from each other. No need to enter the exact time unless you 

want it to appear correctly on the Scheduler (if you are using the scheduler). 

 Method of Contact: for you to keep track of how you interact with clients. Most methods of 

contact will count on funder reports. For VOCA, enter “Hotline/crisis line counseling” in Topics 

Covered for an existing client’s phone service to count in that section.  

 Activity Status: Should always be “Completed” for services you have provided in order to report 

correctly. Use the other options only if you are pre-scheduling appointments or tracking no-

shows and cancellations. If your agency doesn’t use any of the other options, it’s a good idea to 

have your administrator remove them but keep “Completed” as the default value. 

 Service Site: If you have an outreach office or other locations where you regularly provide 

services and want to be able to report separately for each location. (For more specifics, use 

“Other” and the Service Site Detail). 

 Funder: Prepopulated with the most common DV/SA funders. Your agency administrator can 

change the list. 

o VOCA services are reported only when VOCA is entered as the funder. If your position is 

fully funded by VOCA, enter VOCA for all of your services. If your position is partly 

funded by VOCA, follow your agency’s guidelines for how to split up your data-entry. 

o VAWA STOP and SASP also report only services that have STOP or SASP listed as the 

funder. Your agency might use a percentage method for reporting to VAWA, however. 

Follow your agency’s guidelines for entering STOP or SASP as funder for services. 

o DCF and SAVS Reports include services from any funder, based on the category and 

service provided to the client and in some cases to the victimization: DV, SA or dual. 

There is no need for these reports to enter DCF or SAVS as a funder. Appropriate 

services with VOCA or other funders entered will still count on the DCF or SAVS report.  

(You can add DCF or SAVS as funders if you have another reason to attach these funders 
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to specific activities, but that will not determine how the activities are counted on the 

DCF and SAVS reports). 

 Program Type: For your convenience; may be helpful if you want to determine which services 

were received while a person was in shelter, or you may come up with another use for this. If 

you only have one program, you can set it as an initial value here and not have to fill it in. 

 Requested but did not receive funded service, and Reason Not Fully Served: for VAWA STOP & 

SASP, and VOCA. 

 Agency Service: If your agency wants to create a more specific list of services in addition to the 

fixed Category and Service options, you can do that here. This is also where your Alice services 

will transfer if you are converting data. 

 Amount: if you are recording an amount or charging for a service, for example rent assistance or 

batterer treatment. See “Billing Info” tab for tracking a client’s charges and payments. 

 Group Service Notes: If you enter a service for multiple clients from the Group Services screen, 

the same notes will appear here for all the clients. If you change this note, it will change for all 

clients. 

 Individual Activity Notes: Just for this client. Do not use as case notes if you want to be able to 

purge the note or hide it from some users. 

 Topics Covered: For VOCA reporting. If you don’t have VOCA funding, or if they decide not to 

ask for this detailed information, you can ignore this field or your agency administrator can 

customize it with different options. 

 Advocate: Defaults to the current user; you can remove if necessary. Entering an advocate here 

will cause the service to appear on their calendar in the Scheduler. You can see whether a 

person is a volunteer here, and if you want to you can sort the list or filter it to include just 

volunteers or no volunteers. 

 

Category & Service:  
*Refer to the Master Services list to find out how services will be counted on each funder report. 

 

CAUTION: These categories and services are mapped to automatically count in the correct area on 

funder reports, and should be modified only with care!  

 

Always choose Category first, to display the relevant services. Funder reports are dependent on the 

combination of categories AND services, and if you choose Service first, you will see some services 

that don’t belong in that category. 

 

Category: 

 

DCF Report will include clients who have received services in these categories: 

Counseling & Advocacy – DV 

Counseling & Advocacy – Dual DV/SA 

Children & Youth Activities if primary victimization is DV or Dual DV/SA 

Specialized Professional Services if primary victimization is DV or Dual DV/SA 

*Remember that DV includes dating violence, stalking, physical and non-physical abuse by 

someone known to the client. 
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SAVS Report will include clients who have received services in these categories: 

Counseling & Advocacy – SA 

Counseling & Advocacy – Dual DV/SA 

Specialized Professional Services (Therapy-Professional) 

  

VAWA reports include clients with services where STOP or SASP are entered as the funder. 

Categories & services are counted based on whether they map to STOP or SASP services. 

  

Category “Other: Not required by state/federal grants” can be used to add your own categories 

as long as they do not overlap any of the state/federal funder categories. Use for any services 

you want to track that you don’t need to report to DCF, SAVS, VOCA, VAWA STOP or SASP, or 

HUD. 

 

Service: Each service, combined with the appropriate category, is mapped to a particular area of a 

funder report. See the Master Services list to find out where combinations of categories and services 

appear on reports. 

 

Some examples: 

 

 Counseling & Advocacy-DV + Crisis Counseling/Advocacy will count as 

o “Supportive counseling & advocacy - individual” for DCF 

o and “Crisis Intervention” for VAWA STOP if one is chosen as the funder. 

 Counseling and Advocacy-Dual DV/SA + Group-Teen will count as 

o “Supportive counseling & advocacy – Children and Youth – group” for DCF (provided the 

client is under 18 at the time of the report) 

o Group Treatment/Support for SAVS 

o Counseling services/Support Group for VAWA SASP or STOP of one is chosen as the 

funder. 

 

Special Instructions for VOCA Reporting 
The VOCA Report beginning October 1, 2015 will not use the Category and Service fields, but 

will count services from the Topics Covered multiple choice field (when VOCA is entered as the 

funder). Some services will also be drawn from hotline calls funded by VOCA. See VOCA Report 

details. 

 

REMEMBER TO SAVE THE ACTIVITY and ALSO SAVE THE CLIENT!!! 

 

Using the Group Service Feature 
New > Group Service 

 

This is a convenience feature and has nothing to do with whether the service is a group or not, although 

it is most pratical for groups. Use it to enter the same activity for several clients at once. The screen is 

the same as the Activity screen but does not include individual client notes. 



 

Osnium WS Basic User Manual page 19 of 29 End Domestic Abuse WI DRAFT 9/30/2015 

 

Activities entered this way will stay grouped unless you split them, after which they become the same 

as individual records. Feel free to split your group after you are finished entering the service. 

 

IMPORTANT: If an activity is part of a group service, any edits will appear in the service for ALL clients in 

the group. This includes edits made to a group service from the individual client’s screen. You 

can tell if an activity is part of a group service if you see the Split Activity icon on the ribbon. 

 Individual notes should be entered in the client’s activity or case notes record. These 

will not show up for anyone else in the group. 

 

To separate activities entered as group services, use the Split Activity icon from the Group Service 

screen or from an individual’s activity record that has been entered as part of a group. When you do 

this, the group will no longer appear as a Group Service in the list and each activity will be treated as an 

individual activity. 

 

Group Services List 
File menu > Lists > Group Services 

To view only Group Services that have not been split, open the Group Services list. Be sure the filter at 

the top is set to “Group Services ONLY.” 

 

Stays (bednights) 
 

Use for shelter, hotel/motel voucher, TLP, etc. Your agency administrator should modify the Stay Type 

list to reflect your agency’s programs. 

 Admission Date and Discharge Date: calculates number of nights - no need to create an entry 

for each night, although you will need more than one stay record if a client leaves and returns. 

Any client with an admission date and no discharge date will be shown as “In Shelter” in the 

client list and in shelter reports. 

 Nights are calculated when midnight passes, so nights will not count on this screen if a client 

enters after midnight. If you want this calculation to be accurate, enter a time before midnight.  

 Stays will count on most reports along with client demographics even if the person didn’t stay 

overnight, although the number of nights may not include partial day stays. See notes for 

individual reports for more information. 

 Funder is used when you have a particular funder associated with a stay. However, HUD ignores 

the funder fields and includes all stays that have HUD project entries. 

 

HMIS/HUD entries 

 If you have HUD funding, create HUD “Project entry” and “Project exit” records for your data to 

be included in HUD reports. 

 Some of the client profile data and Stay fields will be automatically entered in the HUD record. 

 You must enter associated stays for household data to be reported correctly on HUD reports. 

 

Fields required for HUD ETH Monthly Report Beginning 10/1/2015 



 

Osnium WS Basic User Manual page 20 of 29 End Domestic Abuse WI DRAFT 9/30/2015 

Project Entry  

 Person Details tab  

   Effective Date (admission date)  

   Client Location  

   Date of birth Carries over from client profile 

   Gender Carries over from client profile 

   Residence prior to project entry  

   Domestic violence victim/survivor Not needed if all of your clients are DV survivors 

   Veteran status If yes 

 Health Information tab  

   HIV/AIDS  

   Disabling condition Carries over from client profile (Disability Y/N) 

   Physical disability Optional or use disabling condition 

   Developmental disability Optional or use disabling condition 

   Substance abuse  

   Mental health  

 Project Exit  

   Effective date (exit date)  

   Destination  

   Changes in health information Optional 

Associated Stays (not a HUD entry) Determines count by household 

 

Associated Stays 
Enter an associated stay when you need to report stays by household. The HUD report will count 

households based on associated stays. The Stays Report will list the head of household in the list so you 

can figure out who belongs together. 

 Add to select a stay record that has already been entered for a family member. 

 New to create a stay record for another client/child/dependent that will be associated with this 

stay record. (It may work better to create the stay in the client or child/dependent’s record first, 

save it and then add it. Sometimes saving for nested data-entry gets complicated). 

 Remove to unlink a highlighted stay from this stay record. 

 Head of Household: choose if there are multiple people in this stay record. 

 

Hotline Calls Tab 
Hotline calls where an existing client was selected in the Call screen will appear here. This area is not for 

substantial or ongoing services provided by phone – enter an Activity instead. 

 

NOTE: This section is generally for recording calls that come in on the hotline. If you provide services by 

phone to an existing client, you should enter it as an activity in the client’s record so the service will be 

counted (you can select “Phone” as the method of contact). Most funders ask to record calls from 

clients as both a hotline call and a service if the hotline operator provides any help before transferring 

the call to the client’s advocate for more in-depth services. 

 

New to add a call 
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Add to link an existing call record with this client 

Remove to unlink an existing call record from this client 

 

See Hotline Calls section for more detail. 

 

Miscellaneous Tabs 
 

Releases of Information Tab 
This is a record of ROIs on file. Be sure to enter an Activity for any time spent on releases. 

 All releases should have an expiration date. You can sort or filter by any column. 

 

REMEMBER TO SAVE THE RELEASE and ALSO SAVE THE CLIENT!!! 

 

Referrals Tab 
This is a record of referrals provided. Be sure to enter an Activity for time spent on referrals. 

 The Referral Destination list is the same as for hotline calls. Users can add new referral 

destinations but follow your agency’s guidelines for how detailed this list should be. 

 

REMEMBER TO SAVE THE REFERRAL and ALSO SAVE THE CLIENT!!! 

 

Court Advocacy/RO’s tab 
This is a record of the status of court cases and restraining orders. Be sure to enter an Activity for any 

legal advocacy services provided. 

 These items can be linked to an abuser and will appear in the Related Cases/ROs tab of the 

abuser’s record. 

 The list of Cases/ROs is a combination, so some columns may not show any data depending on 

the type of record that was entered. 

 

New > Case 

 Fields in the middle section are not used anywhere else in the database and can be customized 

by your agency administrator as needed. 

 

New > Charging Conference – use as needed. 

 

New > Restraining Order 

 Number of temporary and final orders requested AND granted are reported to VAWA SASP, and 

to VAWA STOP by RO Victimization Type, which is a different list here than in the rest of the 

database. Use otherwise per your agency’s needs. 

 

Restraining Order fields reported to funders 

Court Advocacy        

Funder    STOP SASP   
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VictimizationType (Restraining Order 

Victim types) 

   STOP SASP  DV/Dating Violence, 

Sexual Assault and 

Stalking 

TRO Date Requested    STOP SASP   

TRO Outcome    STOP SASP   

Injunction Hearing Date    STOP SASP   

Injunction Outcome    STOP SASP   

Date Injunction Granted    STOP SASP   

 

REMEMBER TO SAVE THE Case/RO/Charging Conference and ALSO SAVE THE CLIENT!!! 
 

Outcomes tab 
For your agency’s convenience and other reporting. 

REMEMBER TO SAVE THE OUTCOME and ALSO SAVE THE CLIENT!!! 
 

 

Surveys tab 
To create and enter surveys that are connected to clients. Contact Osnium for assistance creating and 

reporting surveys. 

(Use New > Survey to enter survey results not connected to a client). 

REMEMBER TO SAVE THE SURVEY ENTRY and ALSO SAVE THE CLIENT!!! 
 

Waiting List tab 
Create a waiting list entry for this client, which will appear on the Waiting List screen. 

REMEMBER TO SAVE THE WAITING LIST ENTRY and ALSO SAVE THE CLIENT!!! 
 

Case Notes tab 
Case notes entered here have special features: 

 Case notes can be purged with assistance from Osnium. 

 Users can be assigned roles that limit them to viewing and editing only their own case notes, or 

not viewing case notes at all. 

 Case notes can be locked for editing after a period of time (set in Tools > Show Options > 

Program Options). They can be unlocked by an administrator if necessary. 

Notes fields in other screens do NOT have these features. 

REMEMBER TO SAVE THE CASE NOTE and ALSO SAVE THE CLIENT!!! 
 

Billing Information tab 
Use this to keep track of a client’s account if you bill for services or provide loans. You can also use it to 

track client services billed to another party. Have your agency administrator customize it for your needs. 

 Modify the transaction type options to work for you. 

 Always enter payments as a negative number if you want the balance to compute correctly. 
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 On the Activity tab, you can enter an amount if you provided financial assistance. You don’t 

need to enter it here unless you are keeping track of the balance. 

 You can filter and download this list for more analysis. 

REMEMBER TO SAVE THE ENTRY and ALSO SAVE THE CLIENT!!! 
 

File attachments tab 
Use to upload any type of file.   

 Keep file size and your computer’s capacity in mind. 

 You can delete files if you have delete permission. 

REMEMBER TO SAVE THE ATTACHMENT and ALSO SAVE THE CLIENT!!! 

Waiting List 
File Menu > Waiting List to view all waiting list entries. 

New > Waiting List Entry to go directly to a blank waiting list screen. 

 

 A person must be entered as a client to be added to the waiting list. 

 Service: This is optional, if you have a waitlist for specific non-shelter services. This is a list of ALL 

the services in the database, not by category. 

 Unmet needs for the DCF, SAVS and VAWA STOP & SASP reports are generated from hotline call 

and activities records. You can get more detail from this list if it’s useful to you. 

 

Events 
This is where you enter Community Education, Public Awareness, Training and Meetings. You can also 

use it for other types of events. 

File > Events for a list you can search, filter and download. You can enter a new Event from here as well. 

New > Events to go directly to a blank Event screen. 

 

 Name of Event: so you can identify it. 

 Event Type: Used for funder reports! Your agency administrator may modify the options as long 

as the event types can still be correctly reported. Follow your agency’s guidelines.  

 Focus (Victimization Type):  Used to filter DV/Dual events for DCF and SA/Dual events for SAVS 

reports.  

 Funder: If this event is reported to a specific funder. The same funder list is used throughout the 

database. 

 Address Details: You can fill in whatever you need here; if you’re reporting by county or zip 

code, just enter those values. You’ll see City, County and Zip Code on the Event list. 

 Audience: Use if you need to track repeat audiences. 

 Total # participants: Enter a number here if you are not entering all of the participants in the 

Participants box below. You can do both but use your agency’s guidelines. 

 Staff: - choose staff and volunteers from the user list. 

 Demographics: We’ve included age, race/ethnicity and gender but your agency administrator 

can add any other types of participant information you want to track for events. 
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Reporting Events 
 

There will be an Events report which will include demographics, participant types, staff and volunteers 

but you can get a lot of information from the Events list. At the bottom of any column, right-click and 

select a calculation. When you filter your list, the totals will change. Right-click anywhere in the list and 

select “Export to…” to download the whole list or a filtered list for more analysis. 

 

Volunteer Time 
You can track any type of volunteer activity here, for individuals or groups. 

Volunteers who provide direct client service should be entered in client activities, and those volunteer 

hours will be included in funder reports along with these. If you want to use this area as a volunteer 

“timesheet” be sure to define a specific type of activity that you can subtract or filter from the total 

volunteer hours so you aren’t double-counting. 

 

 Type of Activity: agency-defined, as needed 

 Volunteer Type: agency-defined, as needed 

 Volunteer Group: Use this area if your volunteers are not regular volunteers who are entered as 

users in the database (a user does not need to have access to the database). 

 Volunteers: Add from the user list. You can filter or sort the search list by the Volunteer 

checkbox. If you have a volunteer who has become staff, they may have 2 records until all of 

their volunteer activity has been entered, so be sure to choose the correct one. 

 

This database does not have a place to track information about individual volunteers. Use another 

system for that. 

 

Reporting Volunteer Time 
 

There will eventually be a comprehensive volunteer time report. 

 

You can get a fair amount of data from the Volunteer Time list. At the bottom of any column, right-click 

and select a calculation. When you filter your list, the totals will change. Right-click anywhere in the list 

and select “Export to…” to download the whole list or a filtered list for more analysis. 

 

To get volunteer time performing direct services that you have entered in Activities, run the WI - 

Services Report and include only volunteers in the Advocate field. 

 

Volunteers Who Become Staff 
To correctly separate volunteer time from staff time  
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Donations 
This is not a full-fledged donor management system, but does a reasonable job of tracking simple 

financial contributions and other types of donations. Experiment with it to see if it meets your needs. 

File menu > Donations to see a list. 

New > Donation to directly enter a donation. 

 

 Name: Select an existing donor from the list, or enter a new one. 

 Address, Phone & Email:  These are not saved for the donor as a whole, but only for this 

donation record. You have to enter contact information each time, or else run a report (A Donor 

report has been requested) that will provide the most recent piece of data for that donor. This is 

not high on our statewide priority list for reports but you can use your tech support time to 

request a report from Osnium if it’s something you want. 

 Campaign or Source – select from the list; users can add a new campaign if it’s not listed. 

 

Your agency administrator can modify any of the other drop-down options for this screen. 

 

Other Lists 
File menu > Lists 

These lists can be used to search, sort, filter, open records or download (right-click and select “Export 

To” before or after filtering). They are useful for a quick look at what’s been happening at the agency, or 

to do quick updates on various items. To get totals and counts right-click the bottom of any column. The 

calculation will change as you filter. 

 

 Services: Note the filters on the icon ribbon at the top that combine criteria for categories. 

(Filtering by columns allows you to select only one value) 

 Group Services: Shows services that have been entered as a group (be sure the “Group Services 

Only” filter on the icon ribbon is on). Edits to these services will affect all clients in a group. 

 Stays/Departures/HMIS 

 Intakes: Note the filters above that combine criteria. These are taken from the client’s Main 

Victimization. 

 Referrals: All referrals from the client tabs. 

 

Other lists can be requested from Osnium but will require updating and distributing your model file 

(screen layout). 

Reports 
As new reports are created, you will be able to easily download and import them from Osnium’s 

Wisconsin web page: www.osnium.com/Wisconsin (click on Reports).  Note that reports created for 

other states are unlikely to work in our database. 

 

Go to File menu > Reports > Reports  

http://www.osnium.com/Wisconsin
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Report filtering and options 
You may have several options in the parameters area at the left, depending on the type of the report. If 

you don’t see the parameters, click the ? icon at the top left.  

 

Filters 

 Fields can be filtered to include only certain values. Click the drop-down arrow or … to make 

your selection. Hold down the Ctrl key to select more than one option or the Shift key to select 

a block of options. If you leave the field blank, all values will be included in the report. 

 Combining filters will narrow your results. For example, if you select a Service Site and an 

advocate, only records that contain both that service site AND the advocate will be included. 

 

Report Options 

 Show Details lists all the records that are included in the totals (with selected fields). 

 Summaries: Some reports include data from more than one module (for example, client profile 

and activities).  You can choose whether or not you want to see summary data from each area. 

 Display as Grid/Excel Export: Select “Yes” if you want only the details, which you can export to a 

spreadsheet for further analysis. You are limited to the columns that were predefined for the 

report.  

 Display Filtering: Select “Yes” to show on the report which filters were applied when running 

this report. 

 

 

View, Print or Export a Report 

Click “Submit” to run your report.  

 

When your report is displayed on the screen, use the icons on the toolbar to: 

- Search for text in the report   

- Page, zoom, display multiple pages, add color or a watermark 

 

- send the report by email   

- print (select printer  or quick print to default printer   

- export in a number of formats  

 

Report Category: Generic Reports 
These are reports created specifically for Wisconsin. When you import a report, this is where it will go. 

 

Report Category: HUD Reporting  
These reports generate data from the HUD module, when you create HUD entries in Stays. 
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Display Reports:  
Some screens have display reports, where you can view a report that includes data from the record you 

are looking at. Choose “Show Details” to include associated data. 

 

Import a Report 
Reports for Wisconsin are made available via the Reports link at http://osnium.com/wisconsin.  

- Select the report from the list and click the Download button at the bottom of the screen. Note 

where it was saved (usually to your Downloads folder). The file will have an extension of .repx 

and probably a blank file icon. (If you don’t see the extension, go to your computer’s Folder 

Options from the search box, and in the View tab uncheck “Hide extensions for known file 

types” and OK) 

 

When you are in the Reports area, click the Reports tab at the top of the screen. 

 
 

Click Import / Export Reports > Import Report 

 
- Navigate to the report file that you downloaded, and double-click to import it. You can also 

select multiple reports to import and then OK 

- WAIT. Be patient. You won’t see an hourglass or anything, but in several seconds you will see a 

popup message “The report(s) were imported successfully.” 

- If you accidentally import an extra copy of the report, right-click on it and select Delete. 

 

Export a Report 
To share a report file with another agency, click Import / Export Reports > Export Report. Send it to 

someone by email for them to save and import. 

 

Create a Report 
The report creation tool is a complex interface and will generally require Osnium tech support. You can 

use some of your 8 hours of annual support for this. Reports can be shared among agencies, so you may 

want to coordinate with other Wisconsin programs to spread out your requests and not use up all of 

your support time. If you do request a report, provide clear and detailed documentation of what you 

need to cut down on the time used. 

 

Osnium can post reports they create for you to the download page for others to import. 

http://osnium.com/wisconsin
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Scheduler 
File menu > Scheduler 

Use the checkboxes at the right to select whose calendars to show.  

 Only users who have “Show in scheduler” checked will appear 

 User accounts can be set to allow editing only their own schedules 

 

- All Activities, Events, Volunteer Time, and Donations associated with a user will appear in this 

calendar. 

- New > Administrative Time to enter something on the calendar that’s independent from other 

parts of the database. Can be entered for multiple staff (if user is allowed) and will show up on 

all of their calendars. 

- New > Group Service, Events, Donation, Volunteer Time can also be entered from here. 

- Show multiple dates by selecting them from the calendar at the right (drag or select beginning 

date, then hold down Shift key and click on end date). 

 

Technical Support 
 

Support from Osnium 
 

Go to www.osnium.com/Wisconsin for installation instructions, Osnium support links, and 

downloadable reports. You will also find links to general documentation for WS, although much of it 

may not be applicable to our customized version of the database. 

 

Each agency receives 8 hours/year of support time as part of your annual fee. Osnium will bill you 

directly each year. With our multiple-agency discount, your fee provides support at around $75/hour. If 

you don’t pay the annual fee, or if you request additional support time, the cost will be at their 

considerably higher hourly rate. 

 

Call Osnium for tech support at 888-676-4861 option 2 

 Installation & remote access 

 Your database is not working 

 Request additional reports (reports can be shared among Wisconsin programs) 

 Advanced customization 

 Help with restoring backups 

 Purging case notes 

 Database updates 

 

Support from End Domestic Abuse WI 
 

Go to www.endabusewi.org/osniumws for documentation, training, and resources provided by End 

Abuse WI, specific to the Wisconsin customized version of Osnium WS. 

 

http://www.osnium.com/Wisconsin
http://www.endabusewi.org/osniumws
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End Abuse staff can provide general support to Wisconsin advocates on database use. 

Call 608-237-3451 (or 608-255-0539 ext. 309) or email technology@endabusewi.org. 

 General questions 

 Training 

 Customizing option lists, setting required fields and initial values, etc. 

 Understanding how services and other data flows to funder reports 

 Clarification about how our database is organized 

 Assigning user permissions 

 Data-entry 

 Reporting 

 Agency administrator options 

mailto:technology@endabusewi.org

